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Abstract— Tasikmalaya Regency possesses a wide range of tourism potential, including natural,
cultural, and religious attractions. However, the lack of optimized spatial information regarding the
location and accessibility of tourist destinations poses a challenge in the development of the local
tourism sector. This study aims to map tourism destinations and analyze optimal access routes by
utilizing Geographic Information System (GIS) technology and Network Analysis features. The
methodology includes the collection of spatial and non-spatial data from 60 tourism points, hotels,
and souvenir shops, map digitization using ArcGIS, and network analysis to determine optimal
routes. The analysis reveals that the distribution of tourist destinations and supporting facilities is still
uneven, with a concentration in a few main areas, while some locations remain inaccessible by
adequate transportation. Route visualizations are categorized by short, medium, and long distances
and presented in the form of interactive thematic maps. The final result a map of tourism distribution
and accessibility, can be utilized by the government, tourists, and tourism industry stakeholders as
a reference for planning and developing integrated and sustainable tourism infrastructure.
Keywords- Thematic Maps; Network Analysis; Geographic Information System (GIS)

Abstrak— Kabupaten Tasikmalaya memiliki potensi pariwisata yang beragam, mulai dari wisata
alam, budaya hingga religi. Namun, belum optimalnya informasi spasial terkait lokasi dan aksebilitas
destinasi wisata menjadi kendala dalam pengembangan sektor pariwisata daerah. Penelitian ini
bertujuan untuk memetakan objek-objek destinasi wisata dan menganalisis jalur akses terbaik
dengan memanfaatkan teknologi Geographic information system dan network analysis. Metode yang
digunakan meliputi pengumpulan data spasial dan non-spasial dari 60 titik destinasi wisata, hotel
dan toko oleh-oleh, digitalisasi peta menggunakan ArcGIS serta analisis jaringan untuk menemukan
rute optimal. Hasil analisis menunjukkan bahwa persebaran wisata dan fasilitas pendukung belum
merata, hanya terkonsentrasi di beberapa titik utama, dan sebagian lokasi bekum terjangkau
tranportasi yang memadai. Visualisasi rute dilakukan melalui kategori jarak dekat, sedang dan jauh
serta ditampilkan dalam bentuk peta tematik yang interaktif. Hasil akhir berupa peta persebaran
wisata dan aksebilitas jalur yang dapat dimanfaatkan oleh pemerintah, wisatawan dan pelak industri
pariwisata sebagai acuan dalam pengembangan dan perencanaan infrastruktur kepariwisataan yang
terintegrasi dan berkelanjutan.

Kata Kunci- Peta Tematik; Analisis Jaringan; Geographic Information System (GIS)

. PENDAHULUAN

Kabupaten Tasikmalaya merupakan salah
satu wilayah administratif yang berada di
Provinsi Jawa Barat, Indonesia, dengan
koordinat geografis antara 7°18' hingga 7°45'
Lintang Selatan dan 107°55' hingga 108°25'
Bujur Timur. Secara keseluruhan, luas daerah
ini  mencapai sekitar 2.563,35 kmz2.
Berdasarkan data terbaru, terdapat 60 objek
wisata aktif yang tersebar di 18 kecamatan di
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wilayah tersebut (BPS Kabupaten
Tasikmalaya, 2023). Potensi sektor pariwisata
di Kabupaten Tasikmalaya tergolong sangat
menjanjikan, didorong oleh kekayaan sumber
daya alam, keanekaragaman seni tradisional,
serta produk kerajinan tangan lokal yang
memiliki nilai estetika dan ciri khas budaya
yang kuat.

Namun, potensi yang dimiliki tersebut
belum sepenuhnya tergali dan dikenal oleh
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masyarakat luas, baik dari kalangan
wisatawan domestik maupun mancanegara.
Upaya promosi dan publikasi mengenai
keberadaan destinasi wisata yang ada masih
terbatas, sehingga perlu adanya media
informasi yang dapat menyajikan data wisata
secara visual dan interaktif. Salah satu media
yang potensial dalam mendukung promosi
pariwisata adalah peta jalur wisata. Peta ini
sangat  dibutuhkan, khususnya  oleh
wisatawan yang ingin melakukan backpacking
atau perjalanan mandiri, untuk membantu
mereka dalam menyusun jadwal perjalanan
secara efisien dan efektif. Visualisasi spasial
ini memungkinkan wisatawan untuk melihat
informasi rute, lokasi objek wisata, serta
sarana dan prasarana penunjang seperti
hotel, toko oleh-oleh, restoran, dan terminal.

Studi sebelumnya, seperti pada Desa
Wisata Karang Sidemen, menunjukkan
bahwa pemetaan dan penyajian informasi
spasial mempermudah akses masyarakat dan
wisatawan terhadap lokasi wisata (Latifah et
al.,, 2023). Selain itu, pemetaan jalur
interpretasi mampu menghadirkan tampilan
yang rapi dan presisi, memudahkan
wisatawan lokal maupun asing dalam
memahami informasi yang tersedia (Akmal et
al., 2021). Lebih lanjut, pemetaan jalur juga
berfungsi untuk menampilkan informasi
pendukung lainnya seperti keberadaan
sarana dan prasarana di sepanjang rute
wisata (Resnu et al., 2020).

Melihat kenyataan bahwa belum adanya
informasi resmi mengenai jalur destinasi
wisata, sistem transportasi, toko oleh-oleh,
serta lokasi penginapan di Kabupaten
Tasikmalaya, maka pemetaan jalur wisata
berbasis Sistem Informasi Geografis (SIG)
sangat diperlukan. Dengan menggunakan
pendekatan Network Analysis, jalur destinasi
wisata dapat divisualisasikan secara jelas,
sehingga dapat membantu wisatawan dalam
menentukan lokasi yang akan dikunjungi.
Penelitian ini secara spesifik bertujuan untuk
mengetahui dan merancang alternatif jalur
objek wisata dengan memanfaatkan teknologi
SIG dan analisis jaringan. Hasil penelitian
diharapkan dapat menyediakan informasi
pariwisata berbasis spasial yang dapat
digunakan dalam perencanaan rute dan paket
wisata, sekaligus memberikan masukan
strategis bagi instansi pemerintah maupun
swasta khususnya bagi Dinas Pariwisata dan
Olahraga (Disparpora) dalam pengembangan
sektor pariwisata di Kabupaten Tasikmalaya.
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1. LANDASAN TEORI

A. Rantai Pasok

Rantai pasok dapat dipahami sebagai
suatu sistem terpadu yang mengoordinasikan
berbagai entitas yang terlibat dalam proses
penciptaan dan penyaluran produk maupun
jasa, mulai dari penyedia bahan baku,
produsen, distributor, hingga konsumen akhir
sebagai penerima manfaat. Chopra dan
Meindl (2016) mendefinisikan supply chain
sebagai rangkaian aktivitas yang saling
terhubung dan bertujuan untuk memenuhi
kebutuhan pelanggan melalui pengelolaan
secara efektif terhadap aliran informasi,
barang, serta dana, baik dalam lingkup
internal perusahaan maupun antarorganisasi
yang terlibat dalam jaringan pasokan tersebut.
Dalam konteks pariwisata, rantai pasok
mencakup  komponen-komponen  seperti
lokasi wisata, transportasi, akomodasi, dan
fasilitas pendukung lainnya. Efektivitas rantai
pasok sangat berpengaruh terhadap
pengalaman wisatawan. Oleh karena itu,
pemetaan jalur wisata yang efisien juga
merupakan bagian penting dari optimalisasi
rantai pasok dalam sektor pariwisata
(Christopher, 2016).

B. Perencanaan Transportasi

Perencanaan transportasi adalah proses
sistematis dalam mengembangkan strategi
untuk menyediakan sistem transportasi yang
efisien, berkelanjutan, dan sesuai dengan
kebutuhan masyarakat. Menurut OrtGzar dan
Willumsen (2011), perencanaan transportasi
melibatkan empat tahap utama, yaitu: (1)
pembangunan model transportasi, (2)
peramalan permintaan, (3) evaluasi alternatif
sistem transportasi, dan (4) pemilihan strategi
terbaik berdasarkan kriteria teknis, ekonomi,
dan lingkungan. Dalam konteks wisata,
perencanaan transportasi menjadi kunci
dalam menghubungkan destinasi dengan
fasilitas pendukung lainnya. Jalur transportasi
yang baik akan meningkatkan aksesibilitas
dan kenyamanan bagi wisatawan, serta
mendorong pertumbuhan ekonomi lokal.

C. Penentuan Rute

Penentuan rute atau optimasi rute
merupakan bagian dari analisis jaringan yang
bertujuan untuk menemukan jalur terbaik
antara titik asal dan tujuan berdasarkan
kriteria tertentu, seperti waktu tempuh, jarak,
biaya, atau kemudahan akses. Dalam Sistem
Informasi Geografis (SIG), analisis jaringan
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menggunakan algoritma seperti Dijkstra atau
Shortest Path Algorithm untuk menentukan
rute optimal (Longley et al, 2015).
Penggunaan SIG dalam penentuan rute
wisata membantu  wisatawan dalam
merencanakan perjalanan mereka secara
efisien, sekaligus mendukung penyusunan
paket wisata yang lebih sistematis dan
menarik. Menurut Miller dan Shaw (2015),
teknologi SIG dapat mempercepat proses
analisis spasial serta memberikan hasil
visualisasi yang informatif dan mudah
dipahami.

D. Destinasi Wisata

Destinasi wisata dapat diartikan sebagai
suatu wilayah geografis yang menjadi tujuan
kunjungan individu maupun kelompok dalam
batas-batas administratif tertentu. Kawasan
ini memiliki daya tarik wisata, dilengkapi
dengan infrastruktur pendukung, serta
menampilkan citra yang menarik sehingga
sesuai untuk kegiatan rekreasi, liburan,
ataupun eksplorasi. Nurdin Hidayah (2019)
dalam Haikal (2020) mendefinisikan destinasi
wisata sebagai lokasi yang dituju oleh
wisatawan untuk  melakukan  aktivitas
kepariwisataan. Lokasi yang dimaksud dapat
berupa daerah, kawasan, provinsi, bahkan
suatu negara. Dengan demikian, destinasi
wisata merujuk pada suatu wilayah yang tidak
hanya memiliki fasilitas dan infrastruktur yang
memadai, tetapi juga didukung oleh sumber
daya manusia yang kompeten, aksesibilitas
yang baik, serta citra positif yang dapat
membentuk persepsi dan minat kunjungan
wisatawan.

E. Sistem Informasi Geografis

Sistem Informasi Geografis (SIG) atau
Geographic Information System (GIS) adalah
sistem berbasis komputer yang digunakan
untuk mengumpulkan, mengelola,
menganalisis, dan memvisualisasikan data
spasial atau geospasial. Teknologi ini memiliki
peran penting dalam mendukung proses
pengambilan keputusan berbasis lokasi,
termasuk dalam konteks perencanaan dan
pengelolaan pariwisata. Dalam wilayah
seperti Kabupaten Tasikmalaya yang masih
memiliki keterbatasan dalam penyediaan
informasi spasial terbuka mengenai lokasi dan
jaringan jalur wisata, SIG menjadi alat bantu
yang sangat relevan (Prahasta dalam Resnu
dkk., 2021).

SIG memungkinkan representasi visual
data spasial yang menyerupai peta
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konvensional, namun dengan keunggulan
interaktivitas dan kemampuan manipulasi
data yang lebih tinggi. Data spasial dapat
dipadukan dengan atribut non-spasial, serta
disesuaikan tampilannya berdasarkan
kebutuhan analisis melalui pengaturan
simbol, warna, ukuran, dan bentuk visual
lainnya. Hal ini memungkinkan penyajian
informasi yang lebih dinamis dan informatif
(Gautama, 2016).

Dalam pengembangan sistem jaringan
dan aksesibilitas, SIG juga memiliki fungsi
analisis jaringan (network analysis) yang
sangat krusial. Menurut Aronoff dalam Oktanti
(2012), SIG dapat digunakan untuk
memprediksi  kapasitas  muatan  jalur,
menentukan jangkauan layanan,
memperkirakan rute terpendek atau tercepat,
serta mengalokasikan distribusi beban secara
efisien. Dalam sektor pariwisata, kemampuan
ini memungkinkan pemetaan akses rute
menuju destinasi wisata secara optimal, yang
pada akhirnya  dapat = meningkatkan
kemudahan wisatawan dalam menjangkau
lokasi.

Peta hasil dari SIG tidak hanya berfungsi
sebagai panduan navigasi, tetapi juga
sebagai media promosi untuk mengenalkan
potensi wisata daerah kepada khalayak luas.
Dengan demikian, keberadaan SIG dalam
pengembangan kepariwisataan berkontribusi
signifikan terhadap perencanaan infrastruktur,
promosi digital, dan peningkatan pengalaman
wisatawan (Mustain, 2018).

F. AcrGIS

Sistem Informasi Geografis (SIG/GIS)
didukung oleh berbagai perangkat lunak
pemetaan, salah satunya adalah ArcGIS,
yang dikembangkan oleh perusahaan
Environmental Systems Research Institute
(ESRI). Perangkat lunak ini memungkinkan
pengguna untuk mengelola dan
memanfaatkan beragam format data spasial
secara fleksibel. Menurut Siregar (2014)
dalam Salim (2018), ArcGIS memiliki produk
utama bernama ArcGIS Desktop, vyaitu
perangkat lunak GIS profesional yang bersifat
komprehensif dan terdiri dari tiga komponen
utama, yakni ArcView, Arcinfo, dan ArcEditor.
Melalui platform ini, pengguna dapat
mengakses berbagai fitur, baik yang berbasis
jaringan maupun fungsi-fungsi desktop.
Beberapa fitur penting yang tersedia dalam
ArcGIS mencakup ArcMap, ArcCatalog,
ArcEditor, Toolbox, serta sejumlah fungsi
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lainnya yang mendukung proses analisis dan
visualisasi data spasial secara menyeluruh.

G. Analisis Jaringan

Network Analysis atau analisis jaringan
merupakan salah satu pendekatan
metodologis yang digunakan untuk menelaah
struktur hubungan serta pola interaksi antar
elemen atau aktor (node) yang terhubung
dalam suatu sistem jaringan (Arifin dan
Apipah, 2024). Dalam konteks
pengembangan destinasi wisata, elemen-
elemen yang berperan sebagai node
mencakup lokasi-lokasi wisata, fasilitas
akomodasi seperti hotel, titik transportasi
seperti terminal, serta pusat perbelanjaan
oleh-oleh. Sementara itu, koneksi antar node
atau edges merujuk pada jalur perjalanan,
rute  transportasi, atau trayek yang
menghubungkan satu lokasi dengan lainnya
dalam sistem jaringan tersebut.

Sebelum analisis lebih lanjut
menggunakan analisis jaringan, langkah
pertama adalah membangun jaringan itu
sendiri. Dalam jaringan destinasi wisata yang
dibangun adalah  undirected network.
Undirected network adalah jaringan yang
menggambarkan node dapat terhubung
dengan edge melalui 2 arah dan saling
berkaitan, berbeda dengan directed network
dimana node nya terhubung oleh edge yang
hanya bisa melakukan jelajah satu arah ke
node yang ditunjuk. Setelah menentukan
node dan edge yang akan digunakan,
selanjutnya adalah melakukan analisis.
Konsep yang akan dibahas dalam analisis ini
meliputi network topology.

Topologi jaringan, atau yang dikenal
sebagai network topology, merujuk pada
konsep yang menjelaskan struktur geometris
serta hubungan fungsional antara komponen-
komponen utama dalam suatu sistem
jaringan. Komponen tersebut terdiri atas node
(titik) yang merepresentasikan  entitas
tertentu, serta edge (sisi atau jalur
penghubung) yang menggambarkan koneksi
atau alur interaksi antar node tersebut. Fokus
utama dari topologi jaringan terletak pada pola
koneksi serta interaksi antar komponen,
termasuk bagaimana tiap elemen saling
terhubung dan jalur mana yang digunakan
untuk mengalirkan data di dalam sistem
jaringan tersebut. Analisis topologi jaringan
dapat memberikan wawasan  dalam
memahami rute perjalanan, serta kondisi jalur
yang dilalui. (Arifin dan Apipah, 2024).
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1R METODE PENELITIAN

Penelitian ini menggunakan pendekatan
kuantitatif dengan metode studi lapangan dan
studi literatur. Data spasial dan non-spasial
dikumpulkan dari Dinas Pariwisata, Pemuda,
dan Olahraga Kabupaten Tasikmalaya serta
melalui observasi langsung menggunakan
aplikasi Maps. Pengolahan dilakukan dengan
perangkat lunak ArcGIS 10.8, melalui tahapan
digitalisasi data, konversi koordinat, serta
pembuatan network dataset. Analisis
dilakukan menggunakan fitur Closest Facility,
Service Area, dan Shortest Path Analysis
untuk memetakan aksesibilitas antar titik.

Data yang berhasil dikumpulkan berupa
titik koordinat masing-masing lokasi wisata,
dan akomodasi yang tersedia. Setelah itu data
disimpan dalam format xIs dengan tiga kolom
utama : Nama, X/Longitude dan Y/Latitude.
Langkah selanjutnya pembuatan peta tematik
untuk mengetahui pola persebaran wisata.
Peta tematik diperoleh dari laman
tanahair.indonesia.go.id berupa peta rupa
bumiindonesia (RBI). Proses pembuatan peta
dilakukan dengan 4 tahapan:

1. Persiapan
Tahap pertama yang harus dilakukan

dalam proses pemetaan adalah menyiapkan

peta dasar berupa Peta Rupa Bumi Indonesia

(RBI) khusus untuk wilayah Kabupaten

Tasikmalaya. Peta ini diperlukan dalam format

data spasial SHP (Shapefile) dan dapat

diperoleh dengan mengunduhnya melalui
platform resmi Ina Geoportal. Selain itu,
diperlukan juga data koordinat masing-masing
lokasi dalam format Excel 97-2003 Workbook

(xIs), yang diperoleh melalui kegiatan

observasi lapangan atau dari data resmi milik

Dinas Pariwisata.

2. Input AcrGIS
Untuk memulainya, masuk ke aplikasi

ArcGIS terlebih dahulu. Tampilan awal nya

ada 2 opsi pilihan: Existing Maps dan New

Maps.

» New Maps - My Template > Blank Map
- Ok.

> File > Add Data > Add Data ... > Cari
folder tempat penyimpanan RBI = Ok.

» File > Add Data > Add XY Data ... 2>
Edit... > Projected Coordinate Systems ->
UTM > WGS 1984 -> Southern
Hemisphere > WGS 1984 UTM Zona 48S
- Ok.

» Agar data tidak hilang / Corrupt setelah
dimasukan ubah format ke SHP dengan
cara Klik Kanan data koordinat - Data -
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Export Data = Pilih Tempat Penyimpanan

- Kasih Nama > Ok.

3. Costum Layout
Gunakan Symbology untuk memperjelas

perbedaan data zona, garis batas dan titik

dengan Klik Kanan pada data - Properties >

Symbology - Categories - Add All Values >

Apply > Ok.

» Kemudian atur layout view agar tata
elemen peta enak dibaca dan informatif

» Ubah koordinat sistemnya dan tambahkan
grid dan frame untuk memperindah
tampilan.

» Tambahkan juga legenda, judul, scale
arrow, scale bar, scale text dan coordinate
system.

4. ModelBuilder
ModelBuilder digunakan dalam penelitian

ini untuk mengotomatisasi dan menyusun
tahapan pemrosesan data spasial dan
analisis jaringan secara sistematis, sehingga
mempercepat  workflow, meminimalkan
kesalahan manual, dan memudahkan
pengulangan proses analisis untuk berbagai
lokasi atau skenario.

» Open Attribute Table - Pilih Kecamatan
(Bantarkalong) > Data - Export Data >
Save

» Tambahkan data jalan dan sungai hasil
download dari laman
tanahair.indonesia.go.id

» Gunakan Toolbox ModelBuilder dan Clip
Analyst

» Drag Clip Analyst ke ModelBuilder - Klik
Kanan Clip - Open - Input Features isi
dengan Kecamatan > Clip Features isi
Bantarkalong > Pilih Folder penyimpanan
- Ok. Lakukan pada semua data.

» Setelah itu masuk ke ModelBuilder > Run
- Ok.

Setelah peta berhasil dibuat, selanjutnya
adalah membuat jaringan jalan yang
terhubung dengan titik koordinat dari masing-
masing wisata dan akomodasi. Proses
pembuatan jalan dilakukan dengan bantuan
algoritma geopy dan matplotlab.

TABEL 1.
ALGORITMA ANALISIS JARINGAN

Algoritma Network Analysis

1 import pandas as pd
from  shapely.geometry import LineString,
2 mapping
3 import fiona
4 from fiona.crs import CRS
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# Daftar nama sheet yang akan dibaca

sheet_list = [WISATA, 'HOTEL', 'TOKO,
"TRAVEL'

pusat_sheet = 'ALUNALUN'

# Lokasi file Excel

excel_file = 'AxIsx’ # Ganti dengan nama file
kamu jika berbeda

# Fungsi aman untuk parsing angka dari Excel
(dengan koma atau karakter aneh)

def safe_float(value):
if pd.isna(value):
return None
try:

value = str(value).strip().replace(" ",
").replace("\xa0", "").replace(",", ".")

return float(value)
except:

return None

# Fungsi baca titik dari satu sheet

def baca_titik(file, sheet_name):

df = pd.read_excel(file,
sheet_name=sheet_name)

titik_list = []

for idx, row in df.iterrows():
nama = str(row.iloc[0]).strip()
lon = safe_float(row.iloc[1])
lat = safe_float(row.iloc[2])

if lon is None or lat is None:

print(f"”A Koordinat tidak valid di sheet
'{sheet_name}' baris {idx + 2}, dilewati.")

continue
titik_list.append({'nama’: nama, 'lon": lon, 'lat":
lat})
print('l@ Membaca sheet {sheet_name},
ditemukan {len(titik_list)} titik valid")

return titik_list

# Fungsi baca titik pusat dari sheet 'ALUNALUN'

def baca_pusat(file, sheet_name):

df = pd.read_excel(file,
sheet_name=sheet_name)

lon = safe_float(df.iloc[0, 1])
lat = safe_float(df.iloc[0, 2])

if lon is None or lat is None:

raise ValueError(f"Koordinat tidak valid pada
sheet {sheet_name}")
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40
41

42
43
44
45

46
a7
48
49
50
51

52
53

54

55
56
57
58
59

60
61
62
63
64
65
66
67
68

69

70
71

print('l@ Titik pusat {sheet name}: ({lon},
{lat})")

return (lon, lat)

# Fungsi utama
def main():
pusat = baca_pusat(excel_file, pusat_sheet)

garis_list =]

for sheet in sheet_list:
titik_data = baca_titik(excel_file, sheet)
for tin titik_data:
garis = LineString([(t['lon"], t['lat]), pusat])
garis_list.append({

‘geometry': mapping(garis),

'properties’: {iid" len(garis_list),
'kategori': sheet}

)

print('l@ Total garis valid yang dibuat:
{len(garis_list)}")

# Simpan ke shapefile
schema = {
‘geometry": ‘LineString’,

‘properties’: {'id": 'int', 'kategori": 'str'}

with fiona.open(
‘jalur_ke_alunalun.shp',
mode="'w',
driver='"ESRI Shapefile',
crs=CRS.from_epsg(4326),
schema=schema

) as shp:
for g in garis_list:

shp.write(g)

print('[l@  Shapefile ‘jalur_ke_alunalun.shp'
berhasil dibuat dan siap dibuka di ArcGIS/QGIS.")

if _name__=="_main__":

main()

V. HASIL PENELITIAN
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A. Analisis Spasial

Berdasarkan hasil pemetaan
menggunakan ArcGIS, diperoleh visualisasi
spasial yang menunjukkan distribusi destinasi
wisata, hotel, toko oleh-oleh dan agen travel
dalam wilayah kabupaten Tasikmalaya.

Gambar 1. Persebaran Wisata

Hasil pemetaan spasial menunjukkan
bahwa destinasi wisata di Kabupaten
Tasikmalaya tersebar luas, namun

membentuk pola spasial terkonsentrasi di
wilayah selatan, terutama di Kecamatan
Cipatujah dan Karangnunggal. Lokasi seperti
Pantai Cipatujah, Pantai Sindangkerta, dan
Pantai Karangtawulan membentuk klaster
wisata pesisir. Di wilayah tengah dan utara,
persebaran cenderung menyebar dengan
dominasi wisata alam dan budaya, seperti
Curug Dengdeng (Karangnunggal), Kampung
Naga (Salawu), dan Situ Sanghyang
(Tanjungjaya). Analisis spasial ini
menunjukkan adanya potensi pariwisata
berbasis bentang alam dan budaya, namun
juga mengindikasikan beberapa wilayah yang

belum memiliki pendampingan layanan
penunjang secara optimal.
Sementara itu persebaran hotel

berdasarkan hasil pemetaan tidak merata.
Titik-titik akomodasi cenderung membentuk
klaster di  sekitar pusat kabupaten
(Singaparna) dan kawasan wisata pantai
seperti terlihat pada gambar 2.
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Gambar 2. Persebaran Hotel

Hotel seperti D&R Homestay, Family 24
Near, dan Heru Sahara berlokasi di Cipatujah
dan Karangnunggal, sedangkan Hotel Doman
Tasikmalaya, Hotel Dewi Asri, Hotel Maribaya
Indah, dan OYO Homes 90956 berlokasi di
pusat kabupaten. Sementara itu, beberapa
wilayah wisata di utara dan timur seperti
Cigalontang, Sukaratu, dan Rajapolah relatif
tidak memiliki akomodasi di sekitarnya. Hal ini
menunjukkan kesenjangan spasial antara
potensi wisata dan ketersediaan akomodasi.

Gambar 3. Persebaran Toko dan Travel

Persebaran agen travel dan toko oleh-oleh
berada di wilayah selatan dan tengah, namun
belum menjangkau wilayah timur dan utama.
Sehingga menunjukan bahwa akses ekonomi
lokal berbasis wisata masih terpusat dan
belum menyebar ke seluruh kecamatan.

B. Analisis Jaringan

Persebaran  akomodasi  berdasarkan
analisis jaringan dengan titik pusat alun-alun
singaparna dikelompokkan menjadi tiga:

1. Jarak Dekat
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(Samb?ar 4. '.—]arinéan jalan dekat

Objek-objek wisata dalam kategori ini
umumnya terhubung langsung dengan jalan
kolektor dan jalan lokal yang baik, serta
berada dalam waktu tempuh relatif singkat
sekitar < 15Km seperti Situ Sanghyang,
Gunung Galunggung, Pasir Datar dan Batu
Mahpar. Akomodasi seperti Hotel Dewi Asri,
Hotel H. Wawan Tasik, OYO Homes 90956,
dan Penginapan Atta Awun mendukung
kawasan ini dan berperan penting dalam
melayani wisatawan lokal maupun luar
daerah.

2. J_aralf Se_darlg

| NUSUETPS— ettt b st ——

o Géﬁba; 5. jérindan jalan sedang

Pada kategori jarak sedang (15-30 km),
akses menuju wisata seperti Curug
Dengdeng, Curug Panetean, dan Curug Gado
Bangkong memerlukan waktu tempuh sekitar
30—-60 menit dengan kondisi jalan yang mulai
bervariasi. Objek wisata dalam radius ini mulai
menunjukkan keterbatasan akses, namun
masih dapat dijangkau melalui jalan lokal
dengan beberapa ruas jalan sempit atau
menurun. Di zona ini terdapat akomodasi
seperti Penginapan Harapan Putra,
Penginapan Hj. Jaenah, dan Penginapan
Karunia, serta dukungan travel seperti RMJ
Trans Travel meskipun masih terbatas.
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Gambar 6. Jaringan jalan jauh

Wilayah yang tergolong jarak jauh
sebagian besar berada di selatan dan utara
Kabupaten Tasikmalaya, dan banyak di
antaranya memiliki akses jalan terbatas atau
belum terhubung langsung dengan jaringan
jalan kolektor. Waktu tempuh bisa lebih dari 1
jam, bahkan lebih lama pada musim hujan
atau kondisi jalan rusak, destinasi unggulan
seperti Pantai Cipatujah, Pantai Sindangkerta,
Pantai Karangtawulan, serta Curug Ciparay
dan Curug Cibanteng di wilayah Cibalong,
termasuk ke dalam wilayah dengan waktu
tempuh panjang dan keterbatasan
aksesibilitas. Akomodasi yang melayani
kawasan ini mencakup Hotel Ny. Pantai
Selatan, Homestay UU, Hotel Panghegar, dan
Hotel Pantai Indah. Namun, hasil overlay
jaringan jalan menunjukkan bahwa beberapa
penginapan dan wisata di zona ini tidak
terjangkau oleh jaringan jalan yang memadai,
bahkan tidak muncul dalam buffer jaringan
jalan lokal.

Selain itu, hasil overlay antara layer
jaringan  jalan dan titk akomodasi
menunjukkan adanya penginapan yang tidak
terjangkau oleh jalan kendaraan. Beberapa di
antaranya berada di desa wisata seperti
Wakap dan Mekarlaksana, Curug Cibanteng
serta beberapa penginapan seperti Hotel
Pantai Indah yang hanya bisa dijangkau
melalui jalur setapak. Hal ini menunjukkan
adanya persoalan serius dalam konektivitas
yang bisa berdampak pada kenyamanan dan
keselamatan pengunjung, serta efektivitas
pengelolaan wisata itu sendiri.
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Gambar 7. Kecamatan dengan wisata terbanyak

Hasil pemetaan menunjukkan beberapa
kecamatan dengan wisata terbanyak berada
di Kecamatan Cipatujah dengan wisata pesisir
unggulan seperti Pantai Cipatujah, Pantai
Karangtawulan, Pantai Sindangkerta dan
Kecamatan Bantarkalong dengan Desa
Wisatanya serta Kecamatan Cisayong
dengan wisata alam (Curug). Pola persebaran
ini  mengindikasikan bahwa wisata alam
(khususnya pantai dan air terjun) menjadi
kekuatan utama Kabupaten Tasikmalaya.

IV. KESIMPULAN

Berdasarkan hasil analisis spasial dan
evaluasi jaringan persebaran destinasi wisata
serta fasilitas pendukung di Kabupaten
Tasikmalaya, diketahui bahwa distribusi objek
wisata di wilayah ini masih menunjukkan pola
penyebaran yang tidak merata, dengan
konsentrasi yang lebih dominan di bagian
selatan dan sebagian wilayah tengah.
Kecamatan Cipatujah tercatat memiliki jumlah
objek wisata terbanyak, terutama wisata
pantai seperti Pantai Cipatujah, Pantai
Sindangkerta, dan Pantai Karangtawulan. Di
samping itu, Kecamatan Bantarkalong dan
Salawu juga menonjol dengan potensi wisata
alam berupa air terjun dan pengembangan
desa wisata. Namun, persebaran fasilitas
penginapan seperti hotel juga belum merata,
dengan dominasi tertinggi berada di Cipatujah
melalui keberadaan hotel seperti Hotel
Panghegar, Hotel Pantai Indah, dan Family 24
Near yang mendukung pariwisata pantai.
Sementara itu, wilayah tengah seperti
Singaparna dan Sukaratu memiliki fasilitas
penginapan yang menunjang akses ke wisata
alam dan budaya, sedangkan kecamatan
seperti Cigalontang, Sukaraja, dan Rajapolah
masih  mengalami  kekurangan fasilitas
akomodasi meskipun memiliki potensi wisata
yang cukup besar. Selain itu, toko oleh-oleh
dan agen travel juga belum tersebar secara
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luas, dan cenderung terkonsentrasi di pusat
kota dan kawasan wisata utama, seperti di
Singaparna dan Pamijahan untuk toko oleh-
oleh, serta di wilayah tengah dan selatan
untuk agen travel seperti Go GnP Trans dan
RMJ Trans Travel. Analisis jaringan
menunjukkan adanya kesenjangan
aksesibilitas, di mana hanya sebagian
destinasi wisata dan akomodasi yang dapat
dijangkau dalam radius dekat dari pusat
kabupaten (215 km), sedangkan lokasi
dengan jarak sedang (15-30 km) dan jauh
(230 km), seperti Cipatujah, Bantarkalong,
dan Cibalong, menghadapi tantangan kondisi
jalan yang belum merata dan kurang
terhubung dengan jaringan jalan utama.
Bahkan, terdapat beberapa destinasi dan
penginapan di daerah terpencil seperti Curug
Cibentang, Desa Wisata Mekarlaksana, dan
Wakap yang belum dapat diakses melalui
jaringan jalan biasa dan hanya dapat
dijangkau melalui jalan setapak atau jalan
tidak beraspal, sehingga menyulitkan
pengembangan wisata serta menurunkan
kenyamanan pengunjung.
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